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SNAP PAC System Migration TECHNICAL NOTE
Form 1688-231218

INTRODUCTION

This technical note describes migration options for customers moving from older SNAP systems to the SNAP 
PAC System™. This note explains the SNAP PAC System (below) and its similarities to earlier systems (page 4), 
defines legacy products (page 6), and shows you how to migrate to PAC Project software (page 7) and mix old 
and new hardware (page 11).

Legacy Software Migration Technical Notes

This technical note does not address the details of moving an existing control strategy or HMI project created 
using Opto 22’s older Cyrano® or FactoryFloor software to PAC Project. For these conversions, see the following 
technical notes:
• Opto 22 FactoryFloor® to PAC Project Migration (form 1692)
• Cyrano to OptoControl Migration (form 1169)

A Newer Option: groov EPIC

This technical note describes the SNAP PAC System, which was introduced in 2007. Still sold and supported, 
SNAP PAC Systems have been field-proven in thousands of applications worldwide. However, we introduced 
an even more capable system in 2018: groov EPIC. 

Designed for both automation and industrial internet of things (IIoT) applications, groov EPIC is fully 
compatible with the SNAP PAC System but offers significant additional performance as well as other features 
you may want to consider when migrating from older systems. 

Cybersecurity—groov EPIC adds cybersecurity features to vulnerable industrial automation systems, 
including a configurable device firewall, data encryption, user accounts, and security certificate management. 

Control programming options—Flowchart-based PAC Control, any IEC 61131-3 compliant language with 
the CODESYS® Development System, or custom applications you build with secure shell access (SSH) to the 
EPIC’s Linux® operating system.

Other included software—Securely share system data with company and cloud-based software, legacy 
PLCs, SCADA systems, and more. Use groov View for your HMI, Node-RED for simple data flows, Ignition or 
Ignition Edge from Inductive Automation® for OPC connectivity, and MQTT for efficient data communication.

UL Hazardous Locations approval—Wide –20 to 70 °C operating temperature range, stainless steel 
construction, and ATEX compliance

Integrated touchscreen—High-resolution color touchscreen lets you commission, troubleshoot, view 
groov I/O specs and wiring diagrams, and see a groov View HMI on the spot. Or use the browser-based 
configuration software from a computer anywhere. 

More about Cybersecurity

Cybersecurity has become a critical issue in automation systems. If you prefer a SNAP PAC System but need 
greater security, one option is to add a groov EPIC processor in front of that system. 

Run your PAC Control strategy on the EPIC instead of a SNAP PAC controller and make sure all communication 
goes through the EPIC. You gain password protection for your system and other security features, as well as 
the ability to more easily share data with diverse legacy equipment, on-premises software, cloud services, and 
other places where you need it. 

For more information, see Products > Cybersecurity and Products > groov EPIC System on the Opto 22 
website. Or call us: 1-800-321-6786 (toll-free from the U.S.A. and Canada) or +1-951-695-3000

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3147
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=1747
https://www.opto22.com/products/groov-epic-system
https://www.opto22.com/products/groov-epic-system
https://www.opto22.com/products/groov-epic-system
https://www.opto22.com/products/groov-epic-system
https://www.opto22.com/products/cybersecurity
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For Help

If you are having trouble with migration issues and cannot find the help you need in this technical note or on 
our website, contact Opto 22 Product Support.

Phone: 800-TEK-OPTO (800-835-6786 toll-free 
in the U.S. and Canada)
951-695-3080
Monday through Friday, 
7 a.m. to 5 p.m. Pacific Time

Email: support@opto22.com

Opto 22 website: www.opto22.com

ABOUT THE SNAP PAC SYSTEM

The SNAP PAC System is an integrated system of hardware and software from Opto 22 for industrial control, 
remote monitoring, and data acquisition applications. 

One of our goals in designing the SNAP PAC System was to make it simpler to understand, select, buy, and 
apply automation hardware and software. To that end we substantially reduced the number of products in 
the SNAP PAC family, while increasing their power, consolidating features, and making certain that they all 
work together. 

The components of the system are:
• PAC Project Software Suite
• SNAP PAC controllers
• SNAP PAC serial brains (see note, below)
• SNAP I/O™ modules

The diagram “Building a SNAP PAC System” on page 3 helps explain these components. 

NOTE: The SNAP PAC System previously included SNAP PAC Ethernet brains (SNAP-PAC-EB1 and SNAP-PAC-EB2). But 
due to the unavailability of parts, as of March 1, 2022, we are no longer able to manufacture them. Instead, you can 
use a SNAP-PAC-R1 controller as a brain; it has all the same features plus additional power and programmability, if 
you need it.

NOTE: Email messages and phone calls 
to Opto 22 Product Support are 
grouped together and answered in the 
order received.

mailto:support@opto22.com
https://www.opto22.com
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SNAP-PAC-RCK4 (4 modules)

Building a SNAP PAC System

Step 1:
Choose software

Step 2:
Choose controller

Step 3:
Choose brains

Step 4:
Choose I/O

PAC Project Basic
• PAC Control Basic
• PAC Display Basic
• PAC Manager
• PAC Utilities

PAC Project Professional
• PAC Control Professional
• PAC Display Professional
• PAC Manager
• PAC Utilities
• OptoOPCServer
• OptoDataLink
• SoftPAC software-based controller

SNAP PAC S-series
• Standalone
• Dual independent Ethernet 

interfaces; multiple serial 
ports

• Built-in RESTful API and 
HTTP/HTTPS server 

• Large distributed systems
• mistic serial support (with 

PAC Project Pro)

SNAP PAC R-series
• Rack mounted (see racks below)
• Dual independent Ethernet interfaces
• Built-in RESTful API and HTTP/HTTPS server 
• Combination controller and robust brain (no step 3)

- SNAP-PAC-R1: analog, serial, and high-speed digital
- SNAP-PAC-R2: analog, serial, and simple digital

Ethernet: SNAP-PAC-R1
• Combination controller and 

robust brain
• Dual independent Ethernet 

interfaces
• Built-in RESTful API and 

HTTP/HTTPS server 
• Analog, digital, and serial I/O 
• High-speed digital functions

Serial: SNAP-PAC-SB1 or SNAP-PAC-SB2
• RS-485 (2-wire or 4-wire) serial
• Analog and digital I/O* 
• SB1 includes high-speed digital functions

Choose from all SNAP I/O modules, a 
wide selection of analog, digital, and 
serial* modules.

SNAP-PAC-RCK8 (8 modules)

SNAP-PAC-RCK12 (12 modules)

SNAP-PAC-RCK16 (16 modules)

Brain or rack-mounted 
controller and modules 
snap onto SNAP PAC 
racks.**

* SNAP PAC SB-series brains do not support serial modules.
** SNAP-PAC-R1-B controller mounts on a legacy SNAP B-series rack.

SoftPAC (software-based)
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SYSTEM DIFFERENCES AND SIMILARITIES

Parts of the SNAP PAC System are the same as or very similar to legacy Opto 22 products, while other parts are 
different. 

PAC Project Software Suite

If you know ioProject, you know most of PAC Project. When we released version 8.0 of the ioProject software 
suite, we also rebranded the suite itself and some of the software in it so customers would know that it works 
with the SNAP PAC System. In addition, we added a new software application to PAC Project Professional. In a 
later release we also added a software-based controller for PC-based control to PAC Project Pro.

For complete information on current features in PAC Project, see form #1699, the PAC Project Data Sheet. Also 
refer to form #1680, the PAC Project 8.0 Release Notes, and see the Release Notes for the most recent PAC 
Project release.

The following table compares the naming and contents of ioProject and PAC Project suites. 

SNAP PAC Controllers

The SNAP PAC S-series and R-series controllers were introduced in 2005 and 2006 for use with ioProject 
software. These controllers have more power than the older SNAP-LCE and SNAP Ultimate controllers they 
replaced and now offer important additional features, including a developer- and IoT-ready RESTful API 
(application program interface based on the REST architecture), a built-in HTTP/HTTPS server, dual 
independent Ethernet network interfaces and, on the S-series, SB serial brain and legacy serial mistic I/O unit 
support.

Current SNAP-PAC-S1s accept the wider range of 8–32 VDC power, and newer SNAP PACs include a microSD 
card slot for data storage. 

The SNAP-PAC-S2 features four serial ports, and each port can be configured to use RS-232 or RS-485 (2-wire 
or 4-wire). This controller is ideal for communicating with legacy mistic systems that run on a serial network.

For backwards compatibility with older I/O units, the SNAP-PAC-R1-B rack-mounted controller can replace 
legacy SNAP Ultimate I/O or SNAP Ethernet I/O brains on a B-series rack without disrupting field wiring. (See 
more in “About Mounting Racks” on page 13.)

Software-based controller. Also available as a separate purchase or as part of PAC Project Pro is SoftPAC, a 
software-based programmable automation controller that runs on a Microsoft® Windows® computer. SoftPAC 
runs the same PAC Control strategies as a hardware PAC. For more information, see form 2020, the SoftPAC 
data sheet.

SNAP PAC and groov EPIC controllers are used with PAC Project software. 

ioProject Basic (last 
release)

PAC Project Basic (any 
release)

ioProject Pro 
(last release)

PAC Project Pro 

ioControl Basic 7.1 PAC Control Basic ioControl Pro 7.1 PAC Control Pro 

ioDisplay Basic 7.1 PAC Display Basic ioDisplay Pro 7.1 PAC Display Pro 

ioManager 7.1 PAC Manager ioManager 7.1 PAC Manager 

OptoOPCServer OptoOPCServer

OptoDataLink

SoftPAC

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4302 target="_blank"
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4302 target="_blank"
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3134
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SNAP PAC Brains

With the SNAP PAC System, SNAP-PAC-R1 controller/brains and SNAP-PAC-SB brains replace several 
older brains which have passed their limits of capability. SNAP PAC-R1 controller/brains support Ethernet 
networks, and SB-series brains operate over serial RS-485 networks. SNAP-PAC-R1s offer high performance as 
brains, with fast response times. 

Unlike the older SNAP brains for Ethernet and serial networks, SNAP PACs use identical racks and handle all 
SNAP analog and digital modules in any position on the rack. (SB-series brains cannot use SNAP serial 
modules.) Ethernet- and serial-based SNAP PAC brains share the same set of features, although SNAP-PAC-R1 
and SNAP-PAC-SB1 brains add the high-speed digital functions that some projects require. Note that since 
SB-series brains do not support Ethernet, Ethernet-based features such as FTP, email, SNMP, and event 
messages are not available. 

Find more information in the SNAP PAC Brains Data Sheet, form 1689.

SNAP I/O

SNAP I/O modules were first introduced in 1996. Since then, the variety and density of new modules has 
outstripped the ability of older I/O processors to handle them. Four-channel analog modules and all serial 
modules are incompatible with older serial brains and require Ethernet-based controller/brains, and the 
higher density digital and analog modules now demand more capacity than the older Ethernet brains have. 

Several modules released concurrently with the SNAP PAC System (and after its introduction) require SNAP 
PAC R-series controller/brains: 8- and 32-channel analog modules, 16-channel isolated digital inputs, and 
others. New modules we develop now typically require SNAP PAC processors. 

SNAP PAC racks, although sporting a cool new black color, are the same boards inside as our older SNAP 
M-series racks (SNAP-M16, SNAP-M32, etc.). You can use the M-series and SNAP PAC racks interchangeably:
• SNAP-PAC-RCK4 is the same as SNAP-M16. 
• SNAP-PAC-RCK8 is the same as SNAP-M32. 
• SNAP-PAC-RCK12 is the same as SNAP-M48. 
• SNAP-PAC-RCK16 is the same as SNAP-M64. 

WHY MIGRATE TO THE SNAP PAC SYSTEM?

Moving to SNAP PAC hardware and software can expand your control system’s capabilities while maintaining 
your investment in I/O units, sensors/actuators, wiring, and other components. The SNAP PAC System offers 
ways to migrate over time from older products to current products. 

If you have older Opto 22 products, migrating to the SNAP PAC System offers the following:
• Immediate use of existing ioControl strategies, ioDisplay projects, and ioManager configuration files
• More powerful controllers and brains with expanded network capabilities
• Secure access to control strategy variable and I/O point data for use in databases, integration with other 

systems, and Internet of Things (IoT) applications, via a standard RESTful API and HTTP/HTTPS server 
(data returned as standard format JSON)

• Compatibility with groov EPIC controllers (see “A Newer Option: groov EPIC” on page 1).
• Brains for serial networks that can be installed in a multi-drop (daisy-chain) configuration
• A universal rack for all SNAP PAC brains and rack-mounted controllers and all I/O modules, used in any 

position
• New higher density analog and digital I/O modules, plus easier ways to configure and work with points 

on high-density modules

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3148
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• OptoDataLink software for communicating with databases such as Microsoft® SQL, Microsoft Access, and 
MySQL® (purchase OptoDataLink separately or as part of PAC Project Professional)

• A migration path for older mistic serial systems and conversion of older FactoryFloor files (requires PAC 
Project Professional)

• Simplified choices and a family of products that all work together, so that future projects are easier to 
specify and build

WHAT IS A LEGACY PRODUCT?

When we use the term “legacy” product, we generally mean a product originally designed to work with 
pre-SNAP PAC systems. For example, brains that were designed for mistic or Optomux® systems are considered 
to be legacy products. Controllers designed to run FactoryFloor or ioProject software (and not capable of 
running PAC Project software) are also legacy products. FactoryFloor and ioProject are considered legacy 
products, too.

While legacy products may not contain our most up-to-date technology and features, we provide full 
technical support for them. We also continue to offer them for sale as long as possible in order to support 
customers with older Opto 22 systems, since these older systems continue to work and may not require 
updating. 

We also try to provide upgrade and migration paths to protect your investments in field wiring, other 
hardware, labor, and development time. Usually we are able to offer you a new product that includes all the 
same features as a legacy product, plus more, and sometimes at a lower cost. 

For new development we recommend the SNAP PAC System or groov EPIC System. In the SNAP PAC System, 
the hardware listed in the table below is considered legacy. To compare old and new SNAP product features 
and see which products work together, also see form #1693, Legacy and Current SNAP Product Comparison and 
Compatibility Charts. 

Legacy Hardware

Part Number Description
Most recent software 
providing full support

Notes

SNAP-LCM4
SNAP-LCSX
SNAP-LCSX-PLUS
G4LC32 series
M4 and M4RTU series

FactoryFloor controller FactoryFloor 4.1 Replaced by SNAP-PAC-S1 and SNAP-PAC-S2.

SNAP-LCE ioProject controller
ioProject 7.1

PAC Project 8.0*

Replaced by SNAP-PAC-S1. Supported by PAC Project 8.0, 
but 8.0 features are limited. Not supported by PAC Project 
8.1 and higher. Firmware 7.2 or higher required for use with 
PAC Project 8.0 or SNAP PAC brains.

SNAP-UP1-ADS

SNAP Ultimate I/O
ioProject 7.1

PAC Project 8.0*

Replaced by SNAP-PAC-R1. Supported by PAC Project 8.0, 
but 8.0 features are limited. Not supported by PAC Project 
8.1 and higher. Firmware 7.2 or higher required for use with 
PAC Project 8.0 or SNAP PAC brains.

SNAP-UP1-M64
SNAP-UP1-D64

Replaced by SNAP-PAC-R1. Supported by PAC Project 8.0, 
but 8.0 features are limited. Not supported by PAC Project 
8.1 and higher. Firmware 7.2 or higher required for use with 
PAC Project 8.0 or SNAP PAC brains.

SNAP-B3000-ENET
SNAP-ENET-RTC SNAP Ethernet I/O ioProject 7.1 Replaced by SNAP-PAC-R1. Supported by PAC Project 8.0, 

but 8.0 features are limited. Not supported by PAC Project 
8.1 and higher.

SNAP-ENET-D64

SNAP-ENET-S64 SNAP Simple I/O ioProject 7.1

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3135
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3135
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Choosing Documentation 

To make PAC Project software easier to use for new customers, the standard edition of several user’s guides 
shows only the hardware, commands, and procedures directly related to the SNAP PAC and groov EPIC 
systems. If you are using any of the legacy hardware listed above, use the legacy editions of these 
guides. The legacy editions include all hardware, commands, and procedures. 

Both standard and legacy editions of PAC Project documents are installed on your PC when you install PAC 
Project Pro. If you need printed versions of any documents, email us at documentation@opto22.com and 
request the ones you need. 

To see the most current PAC Project documents, search for these form numbers on the Opto 22 website:

HOW TO MIGRATE TO THE SNAP PAC SYSTEM

Migrating from ioProject to PAC Project with an Existing SNAP PAC Controller

If you have been using ioProject Basic or Professional with a SNAP PAC controller, migration to PAC Project 
Basic or Professional is simple. Because the individual programs within the suite are essentially the same 
(although they have new features and hardware support), you can simply use PAC Project to open and save 
your strategy, project, and other files created in ioProject. For safety, we recommend you back up all 
ioProject strategy and project files before opening them in PAC Project.

SNAP-PID-V
PID loop control module 

(one loop)
ioProject 7.1

Replaced by PID loop control built into SNAP-PAC-R1 
controller/brains (96 loops).

B3000
B3000-B

Serial mistic analog/digital brain PAC Project 

Supported in PAC Project Professional with a SNAP PAC 
S-series controller. New products and features, including 
SNAP high-density and four-channel modules, are not sup-
ported.

SNAP-BRS Serial mistic simple digital brain PAC Project 

Replaced by SNAP-PAC-SB1 and SNAP-PAC-SB2 serial 
brains. Supported in PAC Project Professional with a SNAP 
PAC S-series controller. 

B100 Serial mistic digital brain board PAC Project 

B200 Serial mistic analog brain board PAC Project 

G4D16R Serial mistic digital brick PAC Project 

G4D32RS Serial mistic simple digital brick PAC Project 

G4A8R
G4RAX

Serial mistic analog brick PAC Project 

* Not all 8.0 features are supported.

Part Number Description
Most recent software 
providing full support

Notes

If you’re using See these guides

Opto 22 Form #

Standard 
Edition

Legacy 
Edition

PAC Control
PAC Control User’s Guide
PAC Control Command Reference
PAC Control Commands Quick Reference Card

1700
1701
1703

1710
1711
1713

PAC Display PAC Display User’s Guide 1702 1712

PAC Manager PAC Manager User’s Guide 1704 1714

SoftPAC SoftPAC Quick Start Guide 2045

http://www.opto22.com/
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CAUTION: ioControl strategies and ioDisplay projects you open and save in PAC Control and PAC Display cannot be 
opened later in ioControl and ioDisplay. Make sure you back up ioControl and ioDisplay strategy and project files 
before opening them in PAC Project.

IMPORTANT: Be sure to update PAC Control strategy files before updating PAC Display project files. Some 
additional naming checks are made in PAC Control (see “Duplicate Naming Checks” on page 9), and these may 
require that you rename some objects. Once these are renamed in PAC Control, most of them can be automatically 
changed in PAC Display. To do so, in PAC Display choose Tools > AutoCorrect Tags. 

If you need to know the details of where PAC Project is installed, names of executable files, and so on, see 
“Software Suite Directory and Filename Changes” on page 9.

Migrating from ioProject to PAC Project using a New SNAP PAC Controller

If you’ve been using ioProject with a SNAP-LCE or SNAP Ultimate controller and want to use PAC Project, your 
best choice is to upgrade to a SNAP PAC controller, which provides full PAC Project support. When you have 
your new controller, follow these steps.
1. Back up your ioControl strategy to a separate folder.
2. Open your strategy in PAC Control. 
3. Open the Control Engines folder in the Strategy Tree. Right-click the existing controller and choose 

Modify from the pop-up menu. Add your new SNAP PAC controller. 
4. Save the strategy and download it to the new controller. (If you receive errors when downloading, see 

“Duplicate Naming Checks” on page 9.)
5. See “Using I/O Units with SNAP PAC Controllers and PAC Control” on page 11 for additional things you 

need to know. 

Similarly, ioDisplay projects can be backed up, then simply opened in PAC Display. If you configured the new 
SNAP PAC controller in PAC Control under a different name than the old controller, then in PAC Display, change 
the name of the control engine associated with the strategy so it is correct, and verify the path to the updated 
PAC Control strategy. Then choose Tools > AutoCorrect Tags. (See “Duplicate Naming Checks” on page 9.) Save 
the PAC Display project. 

If you are using OptoOPCServer, the changes you made to the control engine in PAC Display are automatically 
sent to the server. In any OPC client applications using OptoOPCServer, make whatever changes are necessary 
for the client to receive data from the new controller. See Chapter 2 of the OptoOPCServer User’s Guide. 

If you need to know the details of where PAC Project is installed, names of executable files, and so on, see 
“Software Suite Directory and Filename Changes” on page 9.

Migrating from ioProject to PAC Project using a SNAP-LCE or SNAP Ultimate 
Controller

If you are currently using a SNAP-LCE or SNAP Ultimate controller with ioProject and cannot upgrade to a 
SNAP PAC controller right now, you have two choices:
• Continue to use ioProject 7.1 with either 7.1 or 7.2 controller firmware. Please be aware that version 

7.1 is the last version of ioProject we will release. New features will be released in PAC Project, not in 
ioProject.

• Install PAC Project 8.0 and install version 7.2 firmware on the controller. (There is no 8.0 firmware for 
these controllers.) Version 7.2 firmware is the final version of 7.x firmware for SNAP-LCE and SNAP 
Ultimate controllers, and is intended to help smooth the transition from them to SNAP PAC controllers.

NOTE: SNAP-LCE and SNAP Ultimate controllers are not supported by PAC Project 8.1 and higher. They can only 
run strategies created with PAC Project 8.0 or ioProject.
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Version 7.2 firmware provides limited support for PAC Project 8.0 features. Here’s what you can and cannot do 
with this combination:
• You can use the Set I/O Unit Configured Flag command and the View I/O Units dialog box in PAC Control. 

This dialog box gives you a more compact view of points in the I/O Unit Inspect dialog box.
• You can use the improved recipe management and improved table control for string tables in PAC 

Display.
• You can use the high-density I/O modules with SNAP PAC brains. You can also use the improved support 

for high-density modules, including individual point names and standard commands, on SNAP PAC 
brains.

• You cannot use the new high-density modules with legacy brains (SNAP Ultimate, Ethernet, or Simple 
brains). You can still use the original three high-density digital modules (SNAP-IDC-32, 
SNAP-ODC-32-SNK, and SNAP-ODC-32-SRC), but only with legacy HDD commands. Individual point 
names are not available with legacy brains.

See “Mixing 8.0 and 7.2 Software and Firmware” on page 10 for additional information. See form #1680, the 
PAC Project 8.0 Release Notes for more information about new features.

Of course, you can also use SNAP Ultimate as an I/O unit with a SNAP PAC controller running PAC Project 8.0. 
See “SNAP PAC Controllers with SNAP Ultimate, Ethernet, or Simple Brains” on page 12 for more information.

If you need to know the directories and filenames for PAC Project, see “Software Suite Directory and Filename 
Changes” on page 9.

Migrating from FactoryFloor to PAC Project

If you have been using the legacy FactoryFloor software suite (OptoControl, OptoDisplay, OptoServer), you can 
migrate to the SNAP PAC System using PAC Project Professional and a SNAP PAC S-series controller, which 
supports mistic serial I/O units. Follow the steps in Opto 22 form #1692, the FactoryFloor to PAC Project 
Migration Technical Note. 

Duplicate Naming Checks

To resolve earlier problems in ioControl, PAC Control now checks for duplicate names of objects such as charts, 
subroutines, strategy variables, OptoScript command names, and reserved keywords (for example, NULL). If a 
naming conflict is found, you may need to rename an object. If you do rename objects in a strategy, also check 
any text files that are downloaded with the strategy and rename objects in them if necessary. 

Once objects in the PAC Control strategy are renamed, the tag database is updated. Always update PAC 
Control strategy files before updating PAC Display project files. 

When you open the project in PAC Display, use Tools > AutoCorrect Tags to make sure all references are 
updated. Note that PAC Display recipe files cannot be updated automatically. If you are using recipe files, 
search for and replace any renamed objects within them.

Software Suite Directory and Filename Changes

With the change from ioProject 7.1 to PAC Project, some filenames and directory names have changed as 
shown below. Note that PAC Control strategy files continue to use the .idb extension, and that some .dll files 
have retained older names.

Old Name Old Files and Directories New Name New Files and Directories 

ioProject \ioProject Software 7.1 PAC Project \PAC Project Software 

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3147
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3147
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MIXING 8.0 AND 7.2 SOFTWARE AND FIRMWARE

Software Versions

You can maintain different ioProject and PAC Project software versions on the same computer without 
problems. For example, if you need to maintain multiple strategies or projects, some of which are in ioProject 
7.1 and some of which are in PAC Project, just leave ioProject installed and install PAC Project, too. 

ioControl 

ioControl.pro.exe
ioControl.basic.exe
ioControlHelp.chm
ioControlCommands.chm
readme_ioControl.txt
\ioControl Pro Examples
\ioControl Basic Examples 

PAC Control 

Control.pro.exe
Control.basic.exe
Control.chm
ControlCommands.chm
readme_Control.txt
\Control Pro Examples
\Control Basic Examples 

ioDisplay Configurator 
ioDisplay Runtime

ioDisC.pro.exe
ioDisR.pro.exe
ioDsrX.pro.exe
ioDisC.basic.exe
ioDisR.basic.exe
ioDsrX.basic.exe
ioDisplayHelp.chm
readme_ioDisplay.txt
\ioDisplayBasicExamples
\ioDisplayBasicSupportFiles
\ioDisplayProExamples
\ioDisplayProSupportFiles 

PAC Display Configurator
PAC Display Runtime

DisplayC.pro.exe
DisplayR.pro.exe
DisplayX.pro.exe
DisplayC.basic.exe
DisplayR.basic.exe
DisplayX.basic.exe
Display.chm
readme_Display.txt
\DisplayBasicExamples
\DisplayBasicSupportFiles
\DisplayProExamples
\DisplayProSupportFiles 

ioManager 
OptoTagG.exe
OPTOTAGG.HLP
readme_ioManager.txt 

PAC Manager 
Manager.exe
Manager.hlp
readme_Manager.txt 

ioTerminal 
ioTerm.exe
IOTERM.HLP
readme_ioUtilities.txt 

PAC Terminal 
ioterm.exe
ioterm.hlp
readme_Utilities.txt 

ioMessageViewer 
ioMessageViewer.exe
ioSniff.hlp

PAC Message Viewer 
MessageViewer.exe
MessageViewer.hlp

Old Name Old Files and Directories New Name New Files and Directories 
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Firmware Versions

Hardware used with PAC Project should be upgraded to the correspondingly numbered firmware if it is 
available. Legacy controllers should be upgraded to 7.2 firmware. The following table shows the minimum 
firmware version required to support specific hardware features.

If you use PAC Control with controllers running firmware versions lower than 7.2 and try to download a 
strategy that uses commands or configurations that require 7.2 or 8.0 firmware, you’ll receive an error 
message. 

The following commands require 7.2 or higher controller firmware:
• Move I/O Unit to Numeric Table
• Move Numeric Table to I/O Unit
• IVAL Move Numeric Table to I/O Unit

The following I/O unit configurations require 7.2 or higher controller firmware:
• Any I/O unit with a maximum digital or analog scantime set
• A Generic OptoMMP Device (This I/O unit configuration is used for a controller if you need to access its 

memory map, for example to read or write to its Scratch Pad area.)

MIXING CURRENT AND LEGACY HARDWARE IN SNAP PAC SYSTEMS

Using I/O Units with SNAP PAC Controllers and PAC Control

If you have a SNAP PAC controller, what changes will you experience when you use PAC Project? The answer 
depends on what brains you are using.

Hardware and features supported

PAC Project Software ioProject Software

Controller 
firmware

Brain firmware
Controller 
firmware

Brain firmware
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SNAP-IDC-32, SNAP-ODC-32-SNK, 
and SNAP-ODC-32-SRC high-density 
digital (HDD) modules 

Individual point names; use of 
standard digital commands

8.0 7.2* 8.0 n/a n/a n/a n/a n/a

No individual point names; use of 
legacy HDD commands 

8.0 7.2 8.0 6.1 7.0 6.1 8.0 6.1

All other HDD modules (Individual point names; use of standard digital 
commands)

8.0** 7.2* 8.0** n/a n/a n/a n/a n/a

SNAP-AITM-8, SNAP-AIV-32, and SNAP-AIMA-32 analog modules 8.0 7.2* 8.0 n/a n/a n/a n/a n/a

All other analog modules with more than 4 points 8.0** n/a 8.0** n/a n/a n/a n/a n/a

SNAP PAC EB- and SB-series brains*** 8.0 7.2 n/a n/a

*Only on SNAP PAC I/O units this controller controls; not on legacy I/O units nor on the SNAP Ultimate I/O unit acting as the controller. 
**New modules are introduced often. See firmware release notes for specific modules supported in each release. 
***SNAP SB-series brains must be connected to an S-series PAC controller.
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SNAP PAC Controllers with SNAP PAC Brains and R-series I/O Units

With current firmware, the SNAP PAC brains (SNAP-PAC-SB1 and SNAP-PAC-SB2 for serial networks) and 
R-series I/O units (SNAP-PAC-R1) support new I/O modules and all features in PAC Project, including the ability 
to configure and use high-density digital (HDD) modules like 4-channel modules. You assign names to the 
points on these modules, they appear in the Strategy Tree along with all other points, and you can use 
standard digital point commands for points on HDD modules. (Configuring an HDD point as a counter 
requires using a SNAP-PAC-R1 or -SB1 I/O unit, however. See “Using High-Density Digital Modules with Mixed 
Systems” on page 13 for more information.) 

The group of HDD commands, such as Get All HDD Module States, have been deprecated: they still work in 
existing strategies, but generally speaking, you don’t need to use them and can treat a point on an HDD 
module exactly as you would any digital point.

When configuring points, you’ll notice that points are now numbered by both their module position number 
and their point number on the module (for example, module 00, point 3; or module 12, point 26). This change 
makes it possible to configure a module with up to 32 points in any position on the rack. 

You’ll also notice that you can configure a 4-channel digital module in any position on the rack. The old 
position 0–7 limitation no longer exists with SNAP PAC brains and SNAP PAC racks. For information on mixing 
brains and racks, see “About Mounting Racks” on page 13.

NOTE: The position limitation does exist for all SNAP-PAC-R1-B controllers (which mount on B-series racks), and for 
SNAP-PAC-R1s with serial numbers less than 600,000. SNAP-PAC-R1s with serial numbers of 600,000 and greater 
support digital modules in any position on a SNAP PAC rack.

SNAP PAC Controllers with SNAP Ultimate, Ethernet, or Simple Brains

Firmware on these brains remains at 7.x. 

SNAP Ultimate, Ethernet, and Simple I/O units retain all the features they had in 7.x. They cannot use the new 
I/O modules or the improved HDD support (see the previous section), but the PAC Control strategy will work 
with these I/O units the same way the older ioControl strategy did. See “About Mounting Racks,” below, for 
rack compatibility issues.

In PAC Project you’ll see a difference in point numbering. ioProject 7.1 assumed a maximum of 64 points on 
any rack, and points on an I/O unit were numbered consecutively, 0–63. Now you’ll see module number/point 
number designations in both PAC Control and PAC Manager. What used to be numbered point 4 will now be 
numbered module 01, point 0; point 63 becomes module 15, point 3, and so on. This change is visible when 
configuring I/O but won’t make any difference in the strategy, because the strategy works with points by 
name, not by number. 

If the SNAP Ultimate I/O is running a strategy, also see the next section, “Using Legacy SNAP-LCE or SNAP 
Ultimate Controllers with Legacy or Current I/O Units.” 

Using Legacy SNAP-LCE or SNAP Ultimate Controllers with Legacy or Current 
I/O Units

If you are using PAC Project 8.0 software with SNAP-LCE or SNAP Ultimate controllers, you’ll need to upgrade 
the controller firmware to version 7.2. 

NOTE: SNAP-LCE and SNAP Ultimate controllers are not supported by PAC Project 8.1 and higher. They can only run 
strategies created with PAC Project 8.0 or ioProject.

With the controller at 7.2 firmware and running PAC Project 8.0, the new modules and the 8.0 point 
numbering and point configuration features are available for SNAP PAC brains only. For legacy SNAP Ultimate, 
Ethernet, or Simple I/O, point numbering and point configuration remain the same as in ioControl 7.1. The 
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three HDD modules supported in 7.1 (SNAP-IDC-32, SNAP-ODC-32-SNK, SNAP-ODC-32-SRC) will still be 
supported in exactly the same way, using HDD commands. New modules are not supported with legacy 
brains.

For additional information, see “Using R1-Based I/O Units with Legacy Controllers” on page 14 and “Using 
High-Density Digital Modules with Mixed Systems” on page 13.

About Mounting Racks

All SNAP PAC R-series controllers and SNAP PAC brains use the same black SNAP PAC racks. The only exception 
is the SNAP-PAC-R1-B, which uses a SNAP B-series rack. 

Older SNAP Ultimate, Ethernet, and Simple brains used a variety of racks depending on the brain’s capabilities. 

In some cases you can mix old and new brains and racks.

M-series racks. As noted on page 5, SNAP PAC racks and M-series racks can be used interchangeably. If you 
have a SNAP Simple brain that you want to replace with a SNAP PAC brain, for example, you don’t have to 
change racks. Similarly, if you have a new black SNAP PAC rack and need to use an older SNAP-UP1-M64 on it, 
you can. 

B-series racks. If you have an I/O unit on a B-series rack, you can replace its brain or controller with a 
SNAP-PAC-R1-B controller, which can be used either as a controller running a PAC Control strategy or simply 
as a powerful brain. With the SNAP-PAC-R1-B you can add to the rack any new SNAP I/O modules that require 
a SNAP PAC processor, such as 16-point digital input modules. However, due to limitations on the B-series rack, 
you cannot use 4-channel digital modules beyond the first eight module positions.

B-series racks do not work with any other R-series controllers, nor with any SNAP PAC brains. 

You cannot use D-series racks with SNAP PAC devices. These racks must be changed.

For details on brain/controller/rack compatibility, see form #1693, Legacy and Current SNAP Product 
Comparison and Compatibility Charts. 

Using High-Density Digital Modules with Mixed Systems

The section “Using I/O Units with SNAP PAC Controllers and PAC Control” on page 11 mentioned the change 
in how high-density digital (HDD) modules are configured, as well as the fact that points on HDD modules 
used with SNAP PAC brains and R-series controllers are generally configured and used like any other digital 
point. 

The exception is in the use of counters. A point on an HDD module used with a SNAP-PAC-R1 controller or a 
SNAP-PAC-SB1 brain can be configured as a counter, and you can use standard counter commands for the 
point. 

But if the module is used with a SNAP-PAC-SB2 (or -R2 or -EB2), the counter feature does not appear as an 
option when configuring the point in PAC Control or PAC Manager. Since counting on an HDD module is done 
in the module itself and is automatic, however, you can still use these counters in two ways: 
• In a PAC Control strategy, use the deprecated HDD commands Get HDD Module Counter(s) and Get & 

Clear HDD Module Counter. (See “Setting Legacy Options in PAC Control” on page 14.)
• In real time, read and clear counters in the PAC Manager Inspect window.

Legacy I/O Units. For SNAP Ultimate, Ethernet, and Simple brains, HDD modules are still treated as they were 
in ioProject 7.1. SNAP Ultimate, Ethernet, and Simple brains support only the following HDD modules:
• SNAP-IDC-32
• SNAP-ODC-32-SNK

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3135
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3135
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• SNAP-ODC-32-SRC

Therefore, if you are running PAC Project on a system with a mix of SNAP PAC I/O units and legacy I/O units, 
your approach to HDD modules may be different depending on the I/O unit:
• With the SNAP PAC I/O units, you can use all HDD modules, configure them just like any other point, and 

use standard digital point commands with them (with the exception of counters as discussed above). 
• With the legacy I/O units, you can use only a few HDD modules, you do not configure them, and you use 

HDD commands with them, exactly as before. HDD commands are deprecated but still available for use. 
(To use them in a new strategy, see “Setting Legacy Options in PAC Control” on page 14.)

Using R1-Based I/O Units with Legacy Controllers

If you need to replace an older SNAP Ultimate, Ethernet, or Simple brain in a system controlled by a SNAP 
Ultimate I/O or SNAP-LCE controller, you can replace it with a SNAP-PAC-R1 controller/brain. (See “About 
Mounting Racks” on page 13 for rack considerations.) Whether you are running ioProject or PAC Project, 
upgrade the controller’s firmware to 7.2. 

NOTE: If you are using PPP over a modem with a legacy brain, you’ll need to replace the brain with a SNAP PAC 
R-series controller/brain, not an EB brain. EB brains do not have a serial port for PPP, but R-series controllers do.

If the I/O unit name and IP address remain the same, you don’t care that the I/O unit type shown in the 
strategy is incorrect, and you’re not planning on using the new I/O modules, either an ioProject or a PAC 
Project strategy can use the new brain without further changes. 

If the new brain will have a different IP address, if you need the I/O unit type shown in the strategy to match 
the physical I/O unit, or if you want to use new I/O modules on the I/O unit, then the replacement is more 
complicated. In this situation, you must:
1. Upgrade controller firmware to 7.2.
2. Change the I/O unit in the strategy. 

a. In the control strategy, rename the I/O unit you are replacing and give it a fictitious IP address. 
b. Add a new I/O unit with the original name, using the correct new IP address and, if running PAC 

Project, the I/O unit type (SNAP PAC brains are not an available I/O unit type in ioProject). Copy all 
the points to this new I/O unit. 

c. Delete the I/O unit you’ve replaced.

All existing points will work as they did before. If you’re running PAC Project, you can use new I/O modules 
supported by PAC Project 8.0 with the new brain. If you’re running ioProject, you cannot use the new modules, 
since they are not recognized by ioProject 7.1. 

USING OPTODATALINK WITH LEGACY HARDWARE

OptoDataLink was designed to be used with SNAP PAC controllers and brains. In addition, however, it also 
supports the following legacy hardware:
• SNAP-LCE and SNAP Ultimate controllers running control strategies created in ioControl
• SNAP Ethernet-based brains whose configuration has been saved in an .otg file using ioManager or PAC 

Manager, or exported from ioControl into an .otg file.

SETTING LEGACY OPTIONS IN PAC CONTROL 

Because our focus in PAC Project is on the SNAP PAC System, PAC Control initially shows only SNAP PAC I/O 
units and the commands used with them. When you’re using the SNAP PAC system only, hiding legacy I/O 
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units and commands makes it simpler and less confusing to build your strategy. However, the legacy 
capabilities are still there and can be made visible in a specific strategy as needed.

Existing Strategies

When you open an existing ioControl strategy in PAC Control, either Basic or Professional, PAC Control will 
automatically show the I/O units and commands appropriate to that strategy. For example, if you have been 
using SNAP Ultimate I/O, SNAP Ultimate I/O units will be visible in the strategy. In addition, commands used 
with SNAP Ultimate I/O but now deprecated because they are not needed with SNAP PACs—such as 
High-Density Digital commands—will also be available. 

Similarly, if you open an existing strategy that contains mistic serial I/O units, all the mistic I/O unit types and 
commands—such as event/reaction and mistic PID commands—will automatically be shown.

New Strategies

When you create a new strategy in PAC Control, either Basic or Professional, the strategy will show only the 
SNAP PAC System. This means:
• When you use a command such as Get I/O Unit as Binary Value, the only I/O units shown for Argument 1 

will be SNAP PAC I/O units (SNAP-PAC-R1, SNAP-PAC-R2, SNAP-PAC-EB1, SNAP-PAC-EB2, SNAP-PAC-SB1, 
and SNAP-PAC-SB2). 

• Commands that are used only with legacy hardware—such as Enable Communication to Mistic PID Loop 
or Clear HDD Module Off-Latches—won’t be listed. 

Since some Opto 22 customers work with multiple systems, legacy options can be set individually for each 
strategy or subroutine. If you are using legacy hardware, you can choose the options that apply to each 
strategy you’re working with, without affecting other strategies.

IMPORTANT: Once you have enabled a legacy option for a specific strategy or subroutine, you cannot disable it 
later for the same strategy or subroutine.

Here’s how to set legacy options:
1. In PAC Control, open the strategy or subroutine for which you want to change options. 
2. Choose File > Strategy Options. Click the Legacy tab.

Depending on the hardware you’re using, you can set one or more of the following options:
– Enable Ethernet, Ultimate, and Simple I/O units and commands (see page 16).
– Enable high-density digital commands (see page 16).
– Enable mistic I/O units and commands (PAC Control Pro only; see page 16).

3. Click the option you want to enable. At the confirmation dialog box, make sure it is correct, and then click 
Yes. Repeat to enable other options.
The options are changed permanently for the strategy or subroutine.
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Enable Ethernet, Ultimate, and Simple I/O Units and Commands

If you’re using any of the I/O unit types shown in the following table, you should enable Ethernet, Ultimate, 
and Simple I/O units and commands. When you do, both the I/O unit types and the commands shown in the 
table will become available in the strategy.

Enable High Density Digital Module Commands

All SNAP high-density digital modules are fully supported by the SNAP PAC System using regular digital point 
commands. However, three of our older HDD modules can also be used with SNAP Ultimate, SNAP Ethernet, 
and SNAP Simple I/O units, if you use the older “deprecated” HDD commands. (Remember that digital-only 
I/O units do not support HDD modules.)

If you are using SNAP-ODC-32-SNK, SNAP-ODC-32-SRC, or SNAP-IDC-32 HDD modules with these older I/O 
units, you should enable High Density Digital module commands. When you do, the following commands 
become available in the strategy:

Enable mistic I/O units and commands

If you’re using legacy mistic hardware with a SNAP PAC S-series controller and PAC Control Professional, you 
should enable mistic I/O units and commands. When you do, the 

following types and commands (see next page) will become available in the strategy:

I/O Unit Types Commands

SNAP-ENET-D64
SNAP-B3000-ENET 
SNAP-ENET-RTC
SNAP-UP1-D64
SNAP-UP1-ADS
SNAP-UP1-M64
SNAP-ENET-S64

IVAL Set Digital-64 I/O Unit from MOMO Masks [DEPRECATED]
IVAL Set Mixed 64 I/O Unit from MOMO Masks [DEPRECATED]
IVAL Set Mixed I/O Unit from MOMO Masks [DEPRECATED]
IVAL Set Simple 64 I/O Unit from MOMO Masks [DEPRECATED]
Set Digital-64 I/O Unit from MOMO Masks [DEPRECATED]
Set Mixed 64 I/O Unit from MOMO Masks [DEPRECATED]
Set Mixed I/O Unit from MOMO Masks [DEPRECATED]
Set Simple 64 I/O Unit from MOMO Masks [DEPRECATED]

Commands

Clear HDD Module Off-Latches
Clear HDD Module On-Latches
Get & Clear All HDD Module Off-Latches
Get & Clear All HDD Module On-Latches
Get & Clear HDD Module Counter
Get & Clear HDD Module Counters
Get & Clear HDD Module Off-Latches
Get & Clear HDD Module On-Latches
Get All HDD Module Off-Latches

Get All HDD Module On-Latches
Get All HDD Module States
Get HDD Module Counters
Get HDD Module Off-Latches
Get HDD Module On-Latches
Get HDD Module States
Set HDD Module from MOMO Masks
Turn Off HDD Module Point
Turn On HDD Module Point

I/O Unit Types Other Types

G4D16R
G4D32RS
G4A8R, G4RAX
B100
B200
B3000, B3000-B (Digital)
B3000, B3000-B (Analog)
SNAP-BRS

Mistic PID Loop
Digital Event/Reaction
Analog Event/Reaction
Event/Reaction Group
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Commands

Clamp Mistic PID Output
Clamp Mistic PID Setpoint
Clear All Event Latches
Clear Event Latch
Clear I/O Unit Interrupt
Convert Mistic I/O Hex String to Float
Convert Number to Mistic I/O Hex String
Disable Communication to Event/Reaction
Disable Communication to Mistic PID Loop
Disable Event/Reaction Group
Disable Interrupt on Event
Disable Mistic PID Output Tracking in Manual Mode
Disable Mistic PID Output
Disable Mistic PID Setpoint Tracking in Manual Mode
Disable Scanning for All Events
Disable Scanning for Event
Disable Scanning of Event/Reaction Group
Enable Communication to Event/Reaction
Enable Communication to Mistic PID Loop
Enable Event/Reaction Group
Enable Interrupt on Event 
Enable Mistic PID Output Tracking in Manual Mode
Enable Mistic PID Output
Enable Mistic PID Setpoint Tracking in Manual Mode
Enable Scanning for All Events
Enable Scanning for Event
Enable Scanning of Event/Reaction Group
Event Occurred?
Event Occurring?
Event Scanning Disabled?
Event Scanning Enabled?
Event/Reaction Communication Enabled?
Event/Reaction Group Communication Enabled?
Generating Interrupt?
Get & Clear Analog Filtered Value
Get & Clear Analog Totalizer Value
Get & Clear Event Latches
Get & Restart Off-Time Totalizer
Get & Restart On-Time Totalizer
Get & Restart Period
Get Active Interrupt Mask 
Get Analog Filtered Value
Get Analog Square Root Filtered Value

Get Analog Square Root Value
Get Analog Totalizer Rate
Get Event Latches
Get Frequency
Get Mistic PID Control Word
Get Mistic PID D Term
Get Mistic PID I Term
Get Mistic PID Input
Get Mistic PID Mode
Get Mistic PID Output Rate of Change
Get Mistic PID Output
Get Mistic PID P Term
Get Mistic PID Scan Rate
Get Mistic PID Setpoint
Get Off-Time Totalizer
Get On-Time Totalizer
Get Period
Get Period Measurement Complete Status
Interrupt Disabled for Event?
Interrupt Enabled for Event?
IVAL Set Digital Binary [DEPRECATED]
IVAL Set Frequency
IVAL Set Mistic PID Control Word
IVAL Set Mistic PID Process Term
IVAL Set Off-Totalizer
IVAL Set On-Totalizer
IVAL Set Period
Mistic PID Loop Communication Enabled?
Read Event/Reaction Hold Buffer
Set Digital I/O Unit from MOMO Masks 

[DEPRECATED]
Set Mistic PID Control Word
Set Mistic PID D Term
Set Mistic PID I Term
Set Mistic PID Input
Set Mistic PID Mode to Auto
Set Mistic PID Mode to Manual
Set Mistic PID Output Rate of Change
Set Mistic PID P Term
Set Mistic PID Scan Rate
Set Mistic PID Setpoint
Transmit/Receive Mistic I/O Hex String


